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Exercise 1: Introduction to ArcGIS Pro 

Welcome! In this introductory exercise, you will start working with ArcGIS 
Pro, the desktop GIS software by Environmental Systems Research Institute 
(ESRI). This desktop software is fully integrated with other ESRI products, 
such as ArcGIS Online, and offers a 64-bit, tab-based interface. It is a very 
powerful tool for viewing spatial data, querying spatial data, making maps, 
conducting spatial analysis, and working with remotely sensed imagery. 
However, before you can make full use of this software, you have to know 
the basics. This is the intention of this exercise.  

Topics covered in this exercise include: 

1. How to open a map project file 
2. How to add layers to a map 
3. How to change the symbology and drawing order of data layers 
4. How to explore layer properties 
5. How to zoom and pan around a map 
6. How to view attribute tables and query attribute information 

 

We will start by navigating to the website and opening the map project file.  

Step 1. Open a Map Project 

Map project files (.aprx files) allow you to work with your spatial data. Within 
a project file, you can store multiple maps, scenes, and map layouts. You 
can also reference a variety of spatial data layers. Note that project files do 
not house the raw data layers. So, if you share this file with a colleague, 
they will be able to open it, but the data layers may not draw correctly or at 
all. You would need to provide the raw data also. In this course, you should 
never deliver a project file, as we will not be able to grade this.  

 

First, we need to download and open the Exercise_1.aprx file.  

� Download the Exercise_1 data from https://www.wvview.org/. All 
data are available on the course webpage and linked to the exercise 
button. You will need to extract the compressed files and save them to 
your local drive.  

� Open ArcGIS Pro. This can be done by navigating to All Apps followed 
by the ArcGIS Folder. Within the ArcGIS Folder, select ArcGIS Pro. 

https://www.wvview.org/
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Note that you can also use a Task Bar or Desktop shortcut if they are 
available on your machine.  

� After ArcGIS Pro launches, select “Open another project.” 

 

� Navigate to the directory that houses the material for this course. The 
project files are in the Exercise_1 folder where it was saved on your 
local machine.  

� Select Exercise_1.aprx. Click OK to open the project.  
� If necessary, navigate to the WV map.  

Note: If you’d prefer, you can also just click on the Exercise_1.aprx file 
within the uncompressed folder directly to launch ArcGIS Pro. 

This project contains one map. This map is for West Virginia and contains 
a variety of data layers. One vector point layers have been provided: 
airports. One vector line layer has been provided: interstates. Two 
vector polygon layer has been provided: limestone and counties. 
Finally, three raster grids have been provided: Land_Cover, elev, and 
hillshade.  

 

We will now further investigate ArcGIS Pro and these data layers.  
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Step 2. Working With the Contents Pane 

The layers displayed on the map are listed in the 
Contents Pane on the left side of the display. Note 
that the map layers are organized by drawing order. 
Layers further up the list display above layers further 
down in the list. Generally, point features draw above 
line features which draw above polygon features. 
Raster layers are generally at the bottom of the list. 
Features that are turned on will have a check mark in 
the box next to the layer name.  

 

Question 1. How many layers are included on this 
map? (2 Points) 

You can turn off layers by clicking in the box to remove the check mark.  

� Check off the counties layer.  

As you can see, when the layer is turned off, you can see layers below it. 
Layers higher up in the list of layers draw above layers that are beneath 
them in the Contents Pane. You can change the drawing order by moving 
the layers around in the Contents Pane. 

� Turn the counties layer back on.  
� Click on the Land_Cover layer and drag it above the counties layer.  

As you can see, the Land_Cover layer is now being displayed above the 
county boundaries. So, if you need to change the drawing order of your 
layers, you can use this method.  

Step 3. Add a New Layer to the Map 

You will now add a new layer to the map within your project. Specifically, 
you will add a vector point layer of spring locations.  

� Click the Add Data button. This button is available under 
the Map Tab within the Layer Section.  

� Navigate to your directory that stores the lab material. 
Specifically, navigate to the Exercise_1 folder. Within this 
folder, there should be a file geodatabase called 
Exercise_1.gdb. Open this database.  

� Within the geodatabase, select the springs feature class. Click OK to 
add it to the map.  
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Note: In this class, we will make use of file geodatabases to store our data. 
This is one of the preferred methods for storing data for use within ArcGIS 
Pro. Inside of a geodatabase, vector data are stored as feature classes.  

Step 4. Change the Symbology of a Point Layer 

Once the point layers have been added to your map, you may want to 
change the symbology. Note that ArcGIS Pro generally will assign a 
symbology randomly, so it may not be optimal to show the features of 
interest.  

� Double-click on the point symbology for the springs in the Contents 
Pane (the point feature used to show the spring locations). The 
Symbology Window should load.  
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This Symbology Window allows you to change the symbology. The Gallery 
allows you to select from and search for available symbols. The Properties 
allow you to manually change the fill and outline color. A search of the 
available symbols in the Gallery didn’t yield an appropriate symbol. So, we 
will change the properties manually. 

� Click on Properties in the Symbology 
Window.  

 
� Click on the Layers Options (looks 

like a grid stack). 
� Change the Color, Outline Color, 

and Size to settings you feel are appropriate.  
� Click Apply to accept the changes.  

  

 

 

 

 

 

Step 5. Change the Symbology of a Line Layer 

You will now change the symbology of the line layer that represents 
interstates. This time, we will use the Gallery.  

� Double-click on the line symbology 
for interstates in the Contents Pane 
(the line feature used to show the 
interstate locations). The Symbology 
Window should now show the 
symbology for this feature as opposed 
to the springs. 

� Navigate back to the Gallery options. 
� Search for “highway.” 
� Select a symbology that seems 

appropriate.  
� Click Apply to accept the changes.  
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Step 6. Change the Symbology of a Polygon Layer 

You will now change the symbology of the limestone layer. This layer shows 
the extent of limestone geology in the state. 

� Double-click on the polygon symbology for limestone in the Contents 
Pane (the polygon feature used to show the limestone extents). The 
Symbology Window should now show the symbology for this feature as 
opposed to the previously selected layer. 

� Click on Properties in the Symbology Window.  
� Click on the Symbol Options (looks like a brush). 
� Change the Color, Outline Color, and Outline Width to 

settings you feel are appropriate.  
� Click Apply to accept the changes.  
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Step 7. Change the Symbology of a Raster Layer 

All of the above examples demonstrated how to change the symbology of 
vector layers: points, lines, and polygons. Now, you will investigate changing 
the symbology of a raster layer. Specifically, we will change the colors used 
to symbolize the elevation data.  

� Right-click on the elev layer then select 
Symbology. 

� In the Symbology Window, leave the 
Symbology as Stretch.  

� Under Color Ramp, change the Color 
Scheme to a color scheme of your 
choosing.  

Note: You may have to turn off some layers 
to see the elevation surface.  

 

 

Step 8. Change a Layer Name in the Contents Pane 

Other than changing the symbology of a layer, you can also change the 
name of the layer in the Contents Pane. Note that this does not change the 
name of the file. It is only changing how the name is displayed in the 
Contents Pane.  

� Right-click on the elev layer then select Properties. 
� Under General options, change the Name to “elevation.” 
� Click OK to accept the change. 
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Step 9. Viewing Feature Attributes 

When you click in the map space and over a map feature, a dialog box 
appears that provides attribute information. This allows for an interactive 
means to explore attribute information.  

� Make sure the counties layer is 
turned on.  

� Click on Monongalia County. A dialog 
box should open that provides 
information about this county. 

Note: If you’re not sure which county is 
Monongalia County, please see the map 
below.  
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Use the information provided to answer the following questions.  

Question 2. What was the population of Monongalia County in 1995?  

(2 Points) 

Question 3. What was the population of Monongalia County in 2005? 

(2 Points) 

Question 4. What is the area of Monongalia County in square miles? 

(2 Points) 

Question 5. Using your answers from above, calculate the population 
density of Monongalia County in 2005 as people per square mile. (2 Points) 

 

� Click on the airport that is furthest north (at the top of the northern 
panhandle).  
 

Use the provided information to answer the following questions. 

Question 6. What is the name of the airport? (2 Points) 

Question 7. What is the elevation of the airport in feet? (2 Points) 

 

Step 10. Moving Around the Map 

Under the Map Tab and in the Navigation Section, a variety of tools are 
available for navigating around the map. 

The Explore Tool allows you to navigate around the map space. Here are 
some pointers. 
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1. Hovering over the Explore Tool 
brings up a dialog box that 
provides navigation information 
(shown here to the right). 

2. Clicking and holding allows you to 
pan around the map space.  

3. You can also pan by using the 
keyboard arrow keys. 

4. Using the mouse roller allows you 
to zoom in and out.  

5. Clicking then selecting shift 
allows you to draw a box to zoom 
in.  

6. Holding down the right mouse 
button and moving the mouse 
allows for continuous zooming.  

7. Holding down V while moving the mouse allows you to rotate the map. 
The map is north oriented by default. 

The Bookmark Tool allows you to bookmark a map position so that you can 
return to it later.  

Generally in ArcGIS Pro, if you hover over a tool, a helpful dialog box will 
load.  

Hover over the tools referenced below to answer the questions posed.  

 

Question 8. What is the purpose of the tool labelled above? (2 Points) 

Question 9. What is the purpose of the tool labelled above? (2 Points) 

Another zoom/panning option is to zoom to the extent of a certain layer.  

� Right-click on the limestone layer in the Contents Pane.  
� Select Zoom to Layer.  

Question 8 

Question 9 
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Question 10. Why did zooming to the full extent of the limestone layer not 
incorporate the full state? (2 Points) 

 

Step 11. Working with Attribute Tables 

One of the benefits of a GIS is the ability to link spatial and aspatial or 
tabulated data. For example, the counties layer available in this project 
does not just provide the county boundaries; it also provides tabulated or 
aspatial data about the counties. You can view this information using the 
attribute table.  

� Right-click on the counties layer and select Attribute Table. 

 

 

The attribute table should open.  

 

� Locate the “SQUARE_MIL” field in the table.  
� Right-click on the field name and select Sort Descending. This will 

reorder the counties in descending order based on area.  
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Question 11. What is the largest county in West Virginia? (2 Points) 

The smallest county should appear at the bottom of the list. Alternatively, 
you can resort the data using Sort Ascending.  

Question 12. What is the smallest county in West Virginia? (2 Points) 

Use similar methods to answer the following questions. 

Question 13. What county had the highest population in the year 2000 
(Use the “POP2000” field)? (2 Points) 

Question 14. What county had the lowest population in the year 2000 (Use 
the “POP2000” field)? (2 Points) 

Question 15. What county had the highest percentage of the population 
under 18 (Use the “UNDER18” field)? (2 Points) 

It is also possible to create a new field in an attribute table. You will now 
create a new field in which to calculate population change.  

� In the counties attribute table, click the Add button.  
� Name the new field “change” (without the quotes). 
� Define the field as Long. 
� In the Fields Tab at the top of the screen, select Save.  

If you navigate to the end of the attribute table, you will see that 
a new field has been added. The field is called “change”. In this field, you 
will now calculate the population change between 1996 and 2006.  

� Right-click on the change field and select Calculate Field. A Calculate 
Field window should open.  

� Provide the expression to calculate change. Here, we will subtract the 
1996 population from the 2006 population. Instead of typing the 
syntax, select (double click) the 1996 and 2006 fields from the list of 
available fields.  

� Once you have generated the syntax, click Run to execute the 
calculation.  
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Back in the attribute table, you should now have numbers in the new 
“change” field. Negative values would indicate decrease in population 
whereas positive value would indicate increase in population. Use this new 
field to answer the following questions.  

Question 16. Which county experienced the greatest population increase 
between these years? (2 Points) 

Question 17. Which county experienced the greatest population decrease 
between these years? (2 Points) 

You can also calculate geometric measures into an attribute column. This 
can be done using the Add Geometry Attributes Tool. You will work with a 
variety of tools in this course, so this will serve as an introduction to setting 
up and running a tool.  

� Navigate to the Analysis Tab then select Tools. This will 
open the Geoprocessing Window.  

� Search for Add Geometry Attributes.  

 

� Click on the tool to open it.  



14 
 

� Set the Input Feature to counties. 
� Add Area to the Geometry Properties list. 
� Set the Area Unit to Square kilometers.  
� Set the Coordinate System to Current Map [Map].  
� Click Run to execute the tool. 

 

 

Back in the counties layer attribute table, you should see that a new field 
named “POLY_AREA” was added to the end of the table. This field now 
contains the area of the county in square kilometers. Use this field to answer 
the following question. 

Question 18. What is the area of Pocahontas County in square kilometers? 
(2 Points) 

Step 12. Saving the Project 

You can save your work by navigating to the Project Tab then selecting 
Save. If you want to save a new copy you can use Save As. Remember to 
save often as you work through the lab exercises.  

Step 13. Creating a New Layout 

To finish this exercise, you will add a new Map Layout to your project. Map 
projects can house multiple 2D and 3D maps along with multiple map 
layouts.  

� Navigate to the Insert Tab and Select New 
Layout.  
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� From the list, select ANSI Portrait Letter 8.5” x 11” (this should be the 
first option). A new blank layout should be added.  

� To add the map to the layout, click on Map Frame 
under the Insert Tab.  

 

In later exercises, you will learn how to create effective map layouts. Here, 
we simply want to show you how to save the map as a graphic file.  

� Navigate to the Share Tab and select Layout.  

 

This will allow you to save a map layout as a graphic file, such as PDF or 
JPEG. When we ask you to turn in a map layout in this class, you will need to 
export it to a graphic file using this method as opposed to providing the 
project file.  

END OF EXERCISE 


